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End User License Agreement (EULA)

WaveRunner (henceforth ‘the Product’) is licensed to you 

as the end user.  Please read this Agreement carefully.

You cannot transfer ownership of these Sounds and Software 

they contain. You cannot re-sell or copy the Product.

LICENSE AND PROTECTION 

1. License Grant

UVI grants to you, subject to the following terms and 

conditions, a non-exclusive, non-transferable right 

to use each authorized copy of the Product. 

The product is the property of UVI and is licensed to you only 

for use as part of a musical performance, live or recorded. This 

license expressly forbids resale or other distribution of the 

sounds and software included in the Product or their derivatives, 

either as they exist on disc, reformatted for use in another 

digital sampler, or mixed, combined, filtered, resynthesized or 

otherwise edited, for use as sounds, multi-sounds, samples, 

multi-samples, wavetables, programs or patches in a sampler, 

microchip or any hardware or software sample playback device. 

You cannot sell the Product content or give it away for use 

by others in their sampling or sample playback devices. 

In the event UVI terminates this agreement due to your 

breach, you agree to return the original and all other 

copies of the software and documentation to UVI.

UVI reserves all rights not expressly granted to herein. 

2. Protection of Software

You agree to take all reasonable steps to protect the product and 

any accompanying documentation from unauthorized copying 

or use. You agree not to modify the product to circumvent any 

method or means adopted or implemented by UVI to protect against 

or discourage the unlicensed use of copying of the Product. 

3. Ownership

As between you and UVI, ownership of, and title to, the 

enclosed digitally recorded sounds (including any copies) 

are held by UVI. Copies are provided to you only to enable 

you to exercise your rights under the license. 

4. Term

This agreement is effective from the date you open this package, 

and will remain in full force until termination. This agreement 

will terminate if you break any of the terms or conditions of this 

agreement. Upon termination you agree to destroy and return to 

UVI all copies of this product and accompanying documentation. 

5. Restrictions

Except as expressly authorized in this agreement, you may not rent, 

sell, lease, sub-license, distribute, transfer, copy, reproduce, display, 

modify or time share the enclosed product or documentation. 

  

©2013 UVI, all rights reserved.
All trademarks are the property of their respective owners 

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.

http://uvi.net/
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WaveRunner

Wavetable Synthesis Retrospective

A multitude of synths, drum machines and rare prototypes of 

esteemed German heritage come together in this massive and 

unparalleled retrospective. WaveRunner presents you with a 

wondrous collection of authentic and fascinating sounds from 

over 30 years of wavetable synthesis. Everything from the 

raw and strident origins to the wild evolving tones of more 

modern, full-featured machines. Each system addressed was 

serviced, meticulously multi-sampled and artfully designed into 

7 unique hybrid instruments driven by over 30,000 samples. 

Both a historical archive of sound and a collection of new and 

unique instruments with hundreds of presets and limitless sound 

design potential, WaveRunner is a suite not to be missed.

WaveRunner includes 7 instruments:

Based on a very old and quite rare machine, WaveRunner 360 

delivers a raw and lo-fi sound. Explore the origins of wavetable 

synthesis and let loose with ripping vintage timbres.

Including sounds from vintage prototype drum modules, synths and 

modern rack drum synths, Terminal D is an uncompromising drum 

machine with an impressive range of sounds and easy to use interface.

Built on a generous collection of sounds from the entire 

range, Terminal U is a powerful and dynamic multitrack 

phrase sequencer capable of generating everything from 

tight rhythmic chains to wild and evolving passages.

Based on the original German blue, WaveRunner 2.0 delivers 

an uncommonly warm and vintage tone from an often 

overlooked classic known for its amazing analog filter.

Similar to the 2.0 but with a distinctly different flavor, 

WaveRunner 2.3 is built on the upgraded German 

classic and its loquacious programming pal.

Based on the modern flagship wavetable synthesizers 

famed in the ‘90’s and ‘00s, WaveRunner Orange delivers 

the modern sound of wavetable synthesis covering the 

gamut from lush bells to violent and evolving tones.

An extraordinary collection of raw waves harvested from 

the entire range of machines come together in this fresh 

and powerful dual-layer subtractive synth; capable of deep, 

modulating ambiances, brutal basses and uncanny leads.

Now lets get started!

Introduction
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Compatibility
  Stand Alone

  Audio Units / RTAS

  VST / MAS / AAX

Minimum System Requirements
  Intel CPU 

  4 GB of RAM 

  17 GB of disk space

  MAC OS X 10.6 or higher

  7200rpm HD or SSD recommended

  UVI Workstation 2 or MOTU MachFive 3

  iLok

  Installation
Copy WaveRunner.ufs to this location: 

/Library/Application Support/UVISoundBanks 

If you’d like to store the library on another hard drive 

you can use an alias in place of the original file 

(so long as the original file remains accessible).

Compatibility 
  Stand Alone

  RTAS

  VST / AAX

Minimum System Requirements
  Core Duo or faster

  4 GB of RAM 

  17 GB of disk space

  Windows Vista or higher

  7200rpm HD or SSD recommended

  UVI Workstation 2 or MOTU MachFive 3 installed

  iLok

  Installation
Copy WaveRunner.ufs to this location: 

C:\Program Files\UVISoundBanks.

If you’d like to store the library on another hard drive 

you can use a shortcut in place of the original file 

(so long as the original file remains accessible).

  What’s a UFS File?

UFS is UVI’s monolithic instrument file format. 

All required assets for an instrument including samples, presets, 

scripts, FX and impulse responses are contained within a single  

UFS file. This approach allows for an extremely simple workflow  

with minimal overhead for file management and updating.

  What’s an iLok?

An iLok is a small USB key that stores licenses for software and 

instruments including all UVI instruments, sound libraries and effects.

You’ll need an iLok key to use this product.

Getting Started

http://uvi.net/
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WaveRunner 360 - Edit Page

Pitch

Page

Drive

Mono / Arp Toggle

Sub Oscillator

Stereo

Effects

Amplitude

Filter

Modwheel

2

3

10

4

1

7

9

6

5

8

1  Page
» Edit/Mod

Sets current page to [EDIT] or [MOD]

2  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» Velocity Sensitivity

Adjust the Velocity > Amp sensitivity

3  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

» Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity Sensitivity

Adjust the Velocity > Filter sensistivity

4  Pitch
» Depth

Sets the Portamento depth in Poly Mode

» Time

Sets the Glide time (in both Mono + Poly)

5  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: detunes layers

6  Sub Oscillator
» Type/Amount

Choose Clean or Dirty signal and the 

amount to be applied 

7  Drive
» Power/Amount

8  Effects
» Power/Amount

Choose from Phaser, Delay, Reverb and 

Ensemble (additional controls available 

in the Effects page of UVIWS and MF)

9  Mono / Arp Toggle
» Mono

Toggle between Mono and Poly voicing

» Arp

Toggle the Arpeggiator On/Off

10  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters

http://uvi.net/
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WaveRunner 360 - Mod Page

Steps + Resolution

Step Sequencer

Seq Controls

Mod Routing

Sync

Waveforms

LFO Controls

Mod Routing

1

2

3

4 5

6

7

8

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

Step Modulator

5  Steps + Resolution
» Steps

Change the amount of steps for the 

sequencer to play

» Resolution

Change the sequencers step length

6  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

7  Sequencer Controls
» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

8  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://uvi.net/
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WaveRunner 360 - Preset List

Bass:

Bubble Bass

Funky Tuba

PPgiator B

Smart Bass

Stereoide

Subphonix

Wheel D Step

Bells and More:

Beauty for Baby

Cosmic Bells

Gong to Bell

Guitar Bells

High Bells

Hybrid Mallet

Isabell

Kenneth Bells

Rabbit Bells

Scan Dreams

So Pretty

Vibrant Bells

Wide Bells

FX and More:

Cave Rising

Detuned Pad

LFO Maniac

Mono Casper

Pitchaphonix

Pro Analog Bubbles

Son of a Witch

WR360 Suspension

Keys:

Analog Piano

Beauty Road

Creamy Keys

Digital P

Ensemble Tines

Fat Full Organ

Final Keys

Grand 360 Piano

Guitar Keys

Hybrid Keyboard

Jazz Attack

Keynalog

On the Road again

Philinostalgia

Reed Electric

Short Electric Piano

Stratoslog

Wavish Keys

Leads:

Analog Miles

Chroma Zone

DynamiNation

Frantic Lead

PicoSolo

Scissor Lead

Scream Organic

Solophonix

Space Clarinet

Syncmulation

WaveRunner Lead 360

Pads:

Almost Choirs

ElectrOrganic

Equinox

Flute Synsations

Jack Phaso

Phasync Sphere

Polymorphing

RS306 Parawavonic

Sean Michael Jar

Slow Gate

Slow Vintage Brass

Solinaxx

Strings Machine

Vibrations

Vocaloid

Wave Browser

Wavescanner

Wheel Interferences

Poly and Brass:

Analog Warm Brass

Fun Table

Hybrid Machine

Kenneth Club Stab

Layer Brass

Linear Brass

Little Brassy

Poly Clav

Poly Ken

Smart Poly

Thrilling

Wha Wheel Me

Raw Factory:

00-Dual Running Waves

01-Road Bellish

02-Pure Bell

03-Indie Scanning

04-Basic Waves

05-360 Brass

06-Digital Orchestra

07-Composite Brass

08-Electric Piano

09-Acoustic Piano Like

10-Vintage Stack

11-Harpsichord

12-Analog Stab

13-Synth Organ

14-Uncle Ytonk

15-Pure Perfect G

16-Table Wurli

17-Simple Bells

18-The Big One

19-Horror Train

20-Gospel Brunch

21-Vox Populi

22-Sweepery

23-Strings in a Box

24-Magic Choir

25-Pretty Thin

26-Soft Organ

27-Full Organ

28-Medium Organ

29-Marimba Like

Presets

http://uvi.net/
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WaveRunner Terminal D

Clear Pattern

Pan

Tune

LP/HP Filter

Step Sequencer

Preset Menu

Play/Stop Toggle

MIDI Indicator

Prev/Next Sample

Mute

Sample Menu

Gain

1

2

8

6

4

5

7

3

9

10

11

12

Global Controls

Modulation Controls:
Pitch Bend » 2 Octave Range

ModWheel » BitCrusher

 Parts:
 Track Allocation

1 + 2  -  Bass / Snare / Clap / Rim

3 + 4  -  HiHats / Cymbals

5 + 6  -  Toms

7 + 8  -  Percussion

 Track Mapping

1: C1 2: D1

3: F#1 4: A#1

5: F1 6: G1

7: C#1 8: D#1

1  Preset Menu
Select from custom Kit + Pattern presets

2  Play / Stop Toggle
Controls the pattern sequencer

3  Clear Pattern
Clears the pattern sequencer

Track Controls

5  Mute
On/Off button to mute the track

5  Sample Menu
Change the tracks sample; choose from a 

large number of included sounds

6  Prev/Next Sample
Loads the previous or next sample from 

the sound library

7  Gain
Set the tracks Gain

8  MIDI Indicator
Activates when there is MIDI activity on 

the tracks corresponding note

9  Pan
Set the tracks Pan

10  Tune
Set the tracks Pitch

11  LP/HP Filter
A combination LP/HP filter; full LP on 

the left, full HP on the right, center is 

neutral (no effect)

12  Step Sequencer
16-step sequencer; click to change 

between values of full velocity, half 

velocity, and no velocity (blank)

http://uvi.net/
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WaveRunner Terminal D - Preset List

01-German Fiesta

02-Hamster Dam

03-Tribalistic

04-Copy and 

Paste

05-So Eighties

06-Industrial

07-One Again

08-Timberland

09-Extatic

10-Steady Beat

11-New School

12-Video Game

13-Numbering

14-Busy Busy

15-Drum So Kit

16-Makossa

17-Attitude

18-Wazza

19-Ricota Floor

20-House Beat

21-Laundromatic

BD:
390 BD 1
390 Gated BD
390 Soft BD
Cameo BD
Cheap BD
Garage BD
Gated One
Gated Two
Harsh BD
HDU BD
Industrial
Noisy Real
Obese BD
Phil Gate
Power BD
Smash BD
Smash Low
Steady BD
Thin Gated
Usai BD 1
Usai BD 2
WA-8Bit BD
WA-8Bit Hard BD
WA-808 BD
WA-808 Long BD
WA-909 BD 3
WA-909 BD1
WA-909 BD2
WA-Acous BD
WA-Analog 1
WA-Analog 2
WA-BeatBox
WA-BrainStorm 1
WA-BrainStorm 2
WA-BrainStorm 3
WA-Cheesy Long
WA-Def BD
WA-Fat BD
WA-Hot BD
WA-House High
WA-Short BD
WA-Steady One
WA-Urban BD
WA-Zap 1
WA-Zap 2

SD/Clap/Rim:
BD SD
Clap1
Clap2
Electro SD
Flat SD
Funky SD
Gated Elec
Granular SD

HP SD
In Your Face
Industrial
James SD
Large SD
Long Brushed
Long SD
Obese SD 1
Obese SD 2
Obese SD 3
Phil is Back
Picollo SD
Power SD 1
Power SD 2
Rim Shot
SD Bender
SD Rim
Simmons SD Tom
Smash
Thin Acoustic
Tube SD
Very Thin
WA Acoustic 1
WA Acoustic 2
WA Acoustic 3
WA Acoustic 4
WA-8Bit Low SD
WA-8Bit Rim
WA-808 Clap 1
WA-808 Clap 2
WA-808 SD 1
WA-808 SD 2
WA-909 Clap 1
WA-909 Clap 2
WA-909 Rim
WA-909 SD 1
WA-909 SD 2
WA-909 SD 3
WA-Analog Rim
WA-Analog SD 1
WA-Analog SD 2
WA-BB Clap 1
WA-BB Clap 2
WA-BeatBox Low
WA-BrainClap 1
WA-BrainClap 2
WA-BrainClap 3
WA-Came SD
WA-Clap Analog
WA-Clap Clean
WA-Clap FX
WA-Clap Sharp 
Long
WA-CR78
WA-D SD
WA-ElectroFX 1
WA-ElectroFX 2

WA-Fatty
WA-FX SD
WA-Hard Clap
WA-Hard Rim
WA-Hard SD Clap
WA-Hard SD
WA-HipHop Clap
WA-HipHop SD
WA-HouseAttack
WA-Long Analog
WA-Phat SD
WA-SD Low Res
WA-Short Acoustic
WA-Simmons SD
WA-Ultra Short SD

Cymbals:
Crash 1
Crash 2
Gong 1
Gong 2
Gong 3
Gong 4
Gong 5
Ride 1
Ride 2
Ride 3
Ride 4
Spercs
Thunder 1
Thunder 2
WA-8Bit Ride
WA-808 Ride 1
WA-808 Ride 2
WA-808 Ride 3
WA-909 Crash FX
WA-909 Crash
WA-Ac China
WA-Ac Crash
WA-Cheesy 1
WA-Cheesy 2
WA-Cheesy 3
WA-CR78 Crash
WA-Fat Crash
WA-Fat Splash
WA-Future Crash
WA-Future Ride
WA-FX Crash
WA-Hard China
WA-Hard Crash
WA-Long Crash

Hi Hats:
390 HH 1
390 HH 2
Term HH C

Term HH O
WA-8Bit HH
WA-808 HH
WA-909 HH 1
WA-909 HH 2
WA-909 HH 3
WA-Ac HH 1
WA-Ac HH 2
WA-Ac HH 3
WA-Ac HH 4
WA-Analog HH 1
WA-Analog HH 2
WA-Analog HH 3
WA-Analog HH O 1
WA-Analog HH O 2
WA-BBox HH 1
WA-BBox HH 2
WA-BBox HH 3
WA-Brain HH 1
WA-Brain HH 2
WA-Brain HH 3
WA-CR78 HH 1
WA-CR78 HH 2
WA-Fat HH 1
WA-Fat HH 2
WA-Fat HH 3
WA-Future HH 1
WA-Future HH 2
WA-FX HH
WA-Hard HH 1
WA-Hard HH 2
WA-Hard HH 3
WA-House HH 1
WA-House HH 2
WA-Rack HH C
WA-Rack HH O
WA-Urban HH C 1
WA-Urban HH C 2
WA-Urban HH O
WT HH C
WT HH O

Toms:
390 Tom 1
390 Tom 2
ETom 1
ETom 2
ETom 3
ETommy
Noise Tom
Rock Tom
Simmons 1
Simmons 2
Timpani 1
Timpani 2
Timpani 3

Timpani 4
Tom 1
Tom 2
Tom SD
Tom Siren
Tom Whistle
WA-808 Tom 1
WA-808 Tom 2
WA-909 Tom
WA-Ac Tom 1
WA-Ac Tom 2
WA-Acous Tom 1
WA-Acous Tom 2
WA-Analog Tom 1
WA-Analog Tom 2
WA-Analog Tom 3
WA-Analog Tom 4
WA-Analog Tom 5
WA-Analog Tom 6
WA-BeatBox Tom
WA-BrainsTom 1
WA-BrainsTom 2
WA-Cheesy Tom 1
WA-Cheesy Tom 2
WA-Cheesy Tom 3
WA-Cheesy Tom 4
WA-CR78 Tom 1
WA-CR78 Tom 2
WA-Demo Tom 1
WA-Demo Tom 2
WA-Demo Tom 3
WA-FaTom 1
WA-FaTom 2
WA-Hard Tom 1
WA-Hard Tom 2
WA-Hard Tom 3
WA-HipHop Tom 1
WA-HipHop Tom 2
WA-HipHop Tom 3
WA-House Tom 1
WA-House Tom 2
WA-House Tom 3

Percussions:
390 Cabassa 1
390 Cabassa 2
390 Power Off
Bamboo1
Bamboo2
Big Wood 1
Big Wood 2
Block 1
Block 2
Bongo 1
Bongo 2
Bongo 3

Brazil Drums 1
Brazil Drums 2
Cabasa
Cajon 1
Cajon 2
Chimes
Conga 1
Conga 2
CowBell
Donkey Jaws
DrumWater 1
DrumWater 2
DrumWater 3
Gong
Guiro 1
Guiro 2
Guiro Voice
One Again
PercDrum 1
PercDrum 2
PercDrum 3
Shaker 1
Shaker 2
Shaker 3
Shaker 4
Shaker 5
Steel 1
Steel 2
Tabla 1
Tabla 2
Tabla 3
Tambourine 1
Tambourine 2
Triangle
WA-8Bit Perc 1
WA-8Bit Perc 2
WA-8Bit Perc 3
WA-8Bit Perc 4
WA-8Bit Perc 5
WA-8Bit Perc 6
WA-808 Perc
WA-Analog Conga
WA-Analog Guiro
WA-Analog Perc
WA-Analog Riding
WA-Analog Stick
WA-Analog Tamb
WA-Analog 
Triangle
WA-Beast Who Fly
WA-Cheesy Tamb
WA-CR78 Clav
WA-CR78 Conga
WA-CR78 Tamb
WA-Elec HH
WA-Future Clave
WA-Future Scratch

WA-Future Zap 1
WA-Future Zap 2
WA-FX Long
WA-Perc InHarm
WA-Scratchos
WA-Space Cowbell
WA-Tambelec
WaterD 1
WaterD 2
WaterD 3
WoodBlock 1
WoodBlock 2
WoodDrum 1
WoodDrum 2
WoodDrum 3

Presets (Kits+Patterns)

Sounds

http://uvi.net/


11

WaveRunner Terminal U

Volume

Pan

Resolution

Gate Amount

Track Effects

Record Toggle

Next Step

Track Steps

Track Pitch

Preset Menu

Sample Menu

Prev/Next Sample

Track On/Off

Per-Step Velocity

Per-Step Pitch

Per-Step Link

1

2

3

4

5

6

7

8

9

10

11

16

12

13

14

15

Global Controls

Modulation Controls:
Pitch Bend » 1 Octave Range

ModWheel » BitCrusher

1  Preset Menu
Load global patches with preset samples 

and sequences

Track Controls

2  Sample Menu
Browse and select samples from the 

included sound library

3  Prev / Next Sample
Loads the previous or next sample from 

the sound library

4  Track On/Off
Toggle button to enable / disable the 

corresponding track

5  Per-Step Velocity
Use the multi-step sequencer to 

program Velocity changes

6  Per-Step Pitch
Adjust the Pitch of each step in 

Semitones

7  Link
When active, step inherets Velocity from 

the previous step

8  Volume
Adjust the track Volume

9  Pan
Adjust the track Pan

10  Resolution
Change the step length

11  Gate Amount
Change the step length (knob value 

ranges from 0 to the Resolution setting)

12  Record Toggle
Record a phrase on your MIDI keyboard

13  Next Step
Adds a blank step to the phrase at the 

current step location

14  Track Steps
Sets the number of steps to playback

15  Track Pitch
Change the pitch of the track in Octaves 

(-2 to +2)

16  Track Effects
Set the desired amount to each of the 

preset effects, including; LP/HP Combo 

Filter, Delay, and Reverb (additional 

controls available on the Effects page of 

UVIWS or MF)

http://uvi.net/
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WaveRunner Terminal U - Preset List

Boss Fight

Carpet Bomber

Charter

Chordomatic

Clock Tease

Costa Del Sol

Dramatic Terminal

Frozen Ambiance

German Jazz

Glass Robin

Gnomon

Ivana Run

Jack

Loki’s Adage

Mainframe

Mana Prism

Mutation

Poly Drummer

Puzzling

Rister

Shadow Universe

Sneaker

Star Dancing

Sunken Palace

Touring

Track n Play

Trapezoid

Unholy Power

Wave Drummer

Bass:

BS - 5Bass

BS - Bowed

BS - Chunk

BS - Cracked

BS - EBass 1

BS - EBass 2

BS - EBass 3

BS - EBass 4

BS - FM Bass

BS - Harsh

BS - JarreBass

BS - Long PWM

BS - PhatSync

BS - Planet

BS - Plucked

BS - PolyWave

BS - Powering

BS - PulseBass

BS - Reso Bass

BS - Short Nose

Bells:

BL - Glass 1

BL - Glass 2

BL - Glass 3

BL - Glocken 1

BL - Glocken 2

BL - Glocken Cello

BL - LaBelle

BL - Sixties Bell

BL - SynthBell

BL - Tubular 1

BL - Tubular 2

Guitars:

GT - Acoustic 1

GT - Acoustic 2

GT - Acoustic 3

GT - Banjo

GT - Distortion

GT - Electric 1

GT - Electric 2

GT - Electric 3

GT - Electric 4

GT - Palm Muted

Keyboards:

KB - Epiano 1

KB - EPiano 2

KB - Epiano 3

KB - Harpsichord 1

KB - Harpsichord 2

KB - Harpsichord 3

KB - Organ 1

KB - Organ 2

KB - Organ 3

KB - Piano 1

KB - Piano 2

Mallets:

ML - eMarimba

ML - FM ToyPiano

ML - Marimba

ML - ToyPiano 1

ML - ToyPiano 2

ML - Vibe

ML - Xylophone

Misc:

Misc - Accordion

Misc - Harmonica 1

Misc - Harmonica 2

Misc - Harp

Misc - IndianFlute

Misc - Koto

Orchestral:

OR - Brass 1

OR - Brass 2

OR - Chimes

OR - Clarinet

OR - Flute

OR - FrenchHorn

OR - Hit 1

OR - Oboe Low

OR - OrcHit 1

OR - OrcHit 2

OR - OrcHit 3

OR - OrcHit 4

OR - OrcHit 5

OR - OrcHit 6

OR - OrcHit 7

OR - OrcHit 8

OR - Saxophone

OR - Strings 1

OR - Strings 2

OR - Strings 3

OR - Trumpet

Synth:

ST - Atmosphere

ST - BrassSynth

ST - Brassy

ST - Breathy

ST - Bubbling

ST - Calm

ST - Cruise

ST - Doop

ST - Epic

ST - FM Orchestra

ST - Kromy

ST - Magneto

ST - Mode2Mode

ST - OldLead

ST - Ping

ST - Plucky

ST - PolySweep

ST - PolyWave

ST - Pulse Bass

ST - PWM Sync

ST - Resonnance

ST - Rich

ST - Short

ST - ShortNasal

ST - sNawBalls

ST - Strings Abstract

ST - Sweet Noise

ST - SyBell

ST - SynthRing

ST - Turn

ST - WaveSweep

Voices:

VX - Ahhh

VX - Choir

VX - Digital Ah

VX - Digital Oh

VX - Evolutive

VX - Looo

VX - Me High

VX - Me Low

VX - Pee

VX - Sooo

VX - Synth Voice

Presets (Instruments+Patterns)

Sounds
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WaveRunner 2.0/2.3

Arp On/Off

Mono Mode

Stereo

Pitch

Sub Oscillator

Effects

Modwheel

Amplitude

Filter

1

2

7

8

4

3

5

6

9

1  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» Velocity Sensitivity

Adjust the Velocity > Amp sensitivity

2  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

» Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity Sensitivity

Adjust the Velocity > Filter sensistivity

3  Pitch
» Depth

Sets the Portamento depth in Poly Mode

» Time

Sets the Glide time (in both Mono + Poly)

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: detunes layers

5  Sub Oscillator
» Type/Amount

Choose Clean or Dirty signal and the 

amount to be applied 

6  Effects
» Power/Amount

Choose from Drive, Phaser, Delay, 

Reverb and Ensemble (additional 

controls available in the Effects page of 

UVIWS and MF)

7  Arp On/Off
Toggle the Arpeggiator On/Off

8  Mono Mode
Toggle between Poly/Mono voicing

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters

CONTINUED ON NEXT PAGE »»
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WaveRunner 2.0/2.3 (continued)

Mod Routing

Sequencer Controls

Step Sequencer

LFO

4

3

2

1

Step Modulator

1  Steps + Resolution
» Steps

Change the amount of steps for the 

sequencer to play

» Resolution

Change the sequencers step length

2  Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

3  Sequencer Controls
» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

4  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

LFO

5  Sync
Enable/Disable LFO sync to Host Tempo

6  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

7  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

8  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

Mod Routing

Waveforms

Sync

LFO Controls

8

6

5

7

http://uvi.net/
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WaveRunner 2.0 - Preset List

Arp - Chord - Step:

Basic Harpeggio

Eighties Autochord

Mallet Planet

Mr Big Stack

OminouStep

Space Water

Tangerine 2020

Underwater

Wheel Step Pad

Bass:

Bass Line Arp

Brassy Bass

Granular Wheel

Hammond Bass

One Finger Wave

Snoop School

Talking Bass

Terminal Bass

Wheel me Up

Bell - Mallet:

Analog Ones

Bell Mundo

Blue Dream Bells

Calm Olive

Clearillon

Ensemble Bells

First Digital Mallet

Flutotron

Inspiring Bells

More Bell the Life

Music Digital Box

Nasal Bells

Organic Bell

Planet Two Zero

PPVibes

Pretty Bell

Pure Wave Bell

Road Like

Steady Bells

Steel Synth Drums

Sweet Bells

Tubularesk

VibraXylaphonic

Xymbalafon

Hybrid - Complex:

Abstract Solo Pad

Analog Harp

Crush Rising

Jet Lagging

Laupering

Miss Large Stack

More Gomonos

Short Stab

Space Poly

Space Power Harp

Stab Chord

Sweep Stack

Typical G

Wave Running

Wavetable Mod

Keyboards:

Acoustic Cheesy

Beautyboard

Clawave

Deep Keys

Electric Softy

Electronic Piano

Ham Big

Key Bells

Keys Portamento

Little Toy Piano

Loud Low Organ

My Dyno Wave

Organ Ensemble

Organ Whaeel

PerKeys Sweet

PhiliPGordia

Piano Electro

Powering Clavinet

PPorGan

Reso Keys Phasing

Round Keys

Space Chapel

Spinocchio

Stack Piano

Synth Piano Forte

Ultra Click Organ

Warm Cheap Piano

Wavepshichord

Wheelham

Zap Organ

Leads:

Air M I

CorsoLO

Digital Solo Voice

German Gomono

Harmonic Alien

Lead Yanky

More than Analog

Nabilead

Play My Bend

So Funky

Soft Brass Lead

String Solo

Tablead

Vibrations

Pads:

Abstraction

Crystal Pad

Digital Choir

Expressive

Harpsypad

Linear Pad

Lituania Pad

Mellow Synth Voices

Poly Pad

Spacial Bed

Steady Pad

Tyra Dark

Vibrant Ohmage

Voice Machine

Polysynth - Brass:

Brass Attack

Brassonic Wave

Conf Horns

Cordo Brass

Ensembrass

Fat Digital Brass

Mellow Funky

Natural Vib

OB Brass

Original Feeling

Pluck Filter

Poly P Synth G

Poly Phonk

Record Classic

Short Env One

Simple Brassy

Softy Brassy

Supa Poly

Tangerine Horns

Trumpets

Very Soft Brass

Strings - Choir:

Blue Soloist

Chorale Robot

Digital Jarre

Heavy Mod Strings

Key Choirs

Poly Machine

Portadroid

Soft Mod Strings

Soline Art

Space Voices

Synth Slow Quartet

Typical Wave Choir

VP Like Strings

Presets
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WaveRunner 2.3 - Preset List

Arp:

Bass Back in Days

Dream Glass Arpeggio

Giorgio Moscito

Piano Arpeggio

Stachords

Tangy Arpy

Wheel Arpy

Bass:

Big Fifth

Classic 80 Bass

Digital Wheel FIlter

Fat Wavetable Bass

Papy G Attidue

Thanks Kenneth

YOU Bass

Zapp Table

Bells and more:

Arti Bells

Beautyful Yes

Churchy

Digital Mallet

Dirty Vox Bell

Discrete Bell

Dyno Bebell

German Fantasia

Glassonix

Mallet Saw

Poly Bells

Pure Bell

Sam Sonic

Smooth Bells

Soft Sensation

Space Christmas

Superbe

Trembells

Wavetable Bell 1

Wavetable Bell 2

Brassy:

Analogic Brass

Brass Table Sweep

Brassteel Drums

Digital Brass

Hybrid Brass

Low Brass

Phat Sax

Plastic Brass

SaxoWaves

Warm Slow Brass

Digital Keys:

A Beautiful One

ExKeylibur

Keys Sta Twa

Mellow Coton

Nasal Keys

Nivea Keys

Power Keys

Pure PG Keys

Round Midnight

Soft Tender

The Last Key

Wavetable Road

Keyboards:

Digital Clav

Dyno GG

Full Organ

Glasscordeon

Grand Digital

HarpsynthChord

Hybrid Organiroad

Jazz Little One

Piano Piano G

Space Harmonium

Sweet RhodOrgan

Synth Caroussel

Tender Waves

Trash Electric Piano

Tutti P Organ

Wursynthzer

Leads:

Digi Funky

Dirty Brass Lead

Fluty Wavy

Fusion Lead

Kosolovo

Little Trumpet

One Dollar Sax

Sad Hollow

Solo on Fire

Solo String Detuned

Whistle Synth

Pads:

Aquarium Flute

Attack Pad

Baurealis

Dark Glassed

Digital Strings

Evoluwaves

French Choirs

Frozen Pad

Glassamento

La Chapelle

Long Island

Mayhem of Pad

Mojave Ambiance

Ominous Digital

One Pad Again

Philadelphia

Poly Pad Step

Side Dark Pad

Slow Rising

Step Dark Voices

Table Sweep

Thanks again K

Typipad

UVIrtuoso

Warm Bed

Wave Rising

YOU Pad

Zebra Sweep

Zenith Ensemble

Polysynth:

Destructured Choir

Funky Short

GuitHarmonix

Malletmania

Origine Brass

Outcasting

Poly Digit

Poly Wave

Soft Guimickal

Soft Phase

True Five

Vintage Poly

Vox Digital 1

Vox Digital 2

Vox Digital 3

Wave Short Stab

Wavetable Stack

Raw Selection:

Danish Choir

Falling Waves

G Full Tines

Glass Brass

Kalimbrass

Kenneth Fantasy

Little Gospel

Melancolie

Metal Road

My Raw Bell

PadPG

PolyPG

Say Wave Low

Talking Waves 1

YOU Tube

Presets
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WaveRunner Orange

Mono Mode

Modwheel

Pitch

Drive

Sub Oscillator

Arp On/Off

Effects

Stereo

Amplitude

Filter

7

4

1

2

9

10

3

6

5

8

1  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» Velocity Sensitivity

Adjust the Velocity > Amp sensitivity

2  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

» Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity Sensitivity

Adjust the Velocity > Filter sensistivity

3  Pitch
» Depth

Sets the Portamento depth in Poly Mode

» Time

Sets the Glide time (in both Mono + Poly)

4  Stereo
» Mode

Off / Alternate Pan

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

5  Sub Oscillator
» Type/Amount

Choose Clean or Dirty signal and amount 

6  Drive
Adjust the amount of Drive applied

7  Effects
» Power/Amount

Choose from Phaser, Delay, Reverb and 

Ensemble (additional controls available 

in the Effects page of UVIWS and MF)

8  Arp On/Off
Toggle the Arpeggiator On/Off

9  Mono Mode
Toggle between Poly/Mono voicing

10  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters

CONTINUED ON NEXT PAGE »»
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WaveRunner Orange (continued)

Steps + Resolution

Sequencer Controls

Mod Routing

Step Sequencer

Mod Routing

LFO Controls

Waveforms

Sync

4

3

2

1

5

7

8

6

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Steps + Resolution
» Steps

Change the amount of steps for the 

sequencer to play

» Resolution

Change the sequencers step length

6  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

7  Sequencer Controls
» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

8  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://uvi.net/
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WaveRunner Orange - Preset List

Arp - Chords:

Ascension

Dead or Bass

Lucid Dreams

Multi Usage

Rasputin

Rolling Aura

Step Choirs

Wheel me Up

Bass:

Demeche Pod

Digital Synsations

Eighty Four Bass

Grand Master Bass

JM Fonk

Large Bottom

Levis Bass

Mini MG Orange

Numeribass

Orange Bass

Pulsation

SynXtra Bass

Taurusing

The Cliche

Wobble Antic

XT Sub

Bells and More:

Creamy Bells

Digital Stack 1M5p

Digital Stack 2

Heaven

Mirabel

Space Vibes

Transbell

W Bells

FX - Evolving:

Boomerang Thruster

Bugati Falling

Cow in Space

Formantic

FX Hybrid Bells

Madeline

Pac Mono

Pad Ring Mod

Particules

Prismatic Evolver

Shubaka

Sleep Late

Sync Asset

The Birds

Wave Trooper

Keys:

Analog Harp

Analog Piano

Beauty Ham Choir

ClavXT

Eighty Four Keys

Full Bar

Kitch Keyboard

Little Harpsichord

Short Piano pCorn

Soft Analog Keys

Tape Keys

Tutti Space

Wanna Keys

Wavetable Keys

Leads:

Eighty Four Lead

Lead Bottom

Orange Lead

Seventies

Short Lead

Stabasolo

Sync Lassic

Tape Bass Lead

Pads:

505 Machine

Analog Strings

Choir XT

Classic Sweep

Hypnotic

Interferences

Jean FIlter Jarre

Joy Pad

Lost in Choir

Love you Saw

Macro Choir 1

Macro Choir 2

MelloVox

Omni Science

OrangeMINOUS

Pad of the Loom

Phase All Hasido

Power of Pad

Pro Analog

Prophecy

Slow Dark Brass

Step Evo Sweep

Sun Laboratory

Sweep HP

Vox in a Box

XT Sympony

Zanzi Pad

Polysynth:

Classic Poly

EDM Chord Stab

Georges Brass

Hollow Pluck

Levis Pop Corn

Orange Poly

Pluckmania

Poly Melody

Poly Sync

Poly Tube

Power Stack

Raw Waves

Slow Phasing

Stab Analog

Sub Aquatic

SynthOrdion

Talk Talk Synth

The Source

Zlatanic

Presets
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WaveRunner X - Edit Page

Layer Globals

Master Gain

Amplifier

Drive

Pages

Presets

Pitch

Edit

2

1

6

5

3

4

7

8

Main Section

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, Mod or Arp

3  Layer Globals
» On/Off Toggle

Turn layers A and B on or off

» Volume

Adjust the Volume of each layer

» Pan

Adjust the Pan of each layer

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Edit
» A | B | AB

Choose to edit layers A or B seperately 

or simultaneously

» Wave Menu

Choose the wave category in the first 

row and the wave in the second

6  Pitch
» Tune

Adjust the pitch in Semitones/Cents

» Depth

Adjust the Portamento depth

» Time

Set the Glide time

» Octave

Adjust the pitch in Octaves

» Mono

Toggle between Mono and Poly voicing

7  Amplifier
» No Velocity

Sets all incoming notes to max velocity

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

8  Drive
Change the amount of Drive

CONTINUED ON NEXT PAGE »»
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WaveRunner X - Edit Page (continued)

Filter

EffectsModwheel 12

10

11

Basic Controls (continued)

9  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: detunes layers

10  Filter
» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» EG Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity

Adjust the Velocity > Filter sensistivity

» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

11  Effects
» Power/Amount

Choose from Phaser, Delay, Reverb and 

Ensemble (additional controls available 

in the Effects page of UVIWS and MF)

12  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

Stereo 9

http://uvi.net/
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WaveRunner X - Mod Page

Mod Routing

Sequencer Controls

Mod Routing

Waveform

LFO Controls

Sync

Steps and Res

Step Sequencer

2

3

1

5

6

4

7

8

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Steps + Resolution
» Steps

Change the amount of steps for the 

sequencer to play

» Resolution

Change the sequencers step length

6  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

7  Sequencer Controls
» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

8  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://uvi.net/
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WaveRunner X - Arp Page

Arp On/Off

Resolution

Arp Mode

Gate

Arp Steps

Octave

Step Indicator

Step Editor

Link

Mono Mode

1

2

3

4

5

6

7

8

9

10

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
16-step sequencer; affects Velocity

3  Link
When active, step inherets Velocity from 

the previous step

4  Mono Mode
When active, Arpeggiator A affects 

both layer A and layer B (whereas 

when disabled each Arp modifies it’s 

corresponding layer only)

5  Arp On/Off
Toggle the Arpeggiator On/Off

6  Resolution
Change the step length

7  Arp Mode
Select Up, Down, or Up and Down

8  Gate
Change the step length (knob value 

ranges from zero to the tracks 

Resolution setting)

9  Arp Steps
Sets the Arpeggiators step length

10  Octave
Set the pitch range of the Arpeggiator 

in Octaves

http://uvi.net/
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WaveRunner X - Preset List

00-Init

Arpeggios:

AR-Calm Down

AR-Duality

AR-Electro Reggae

AR-Little Digital Dream

AR-Move Your Synth

AR-Multipop

AR-Muse Arp Deco

AR-One Note One Wheel

AR-Perfect G

AR-Stellar Wheel

AR-Wheel Fusion

Bell:

BL-Analogic Bell 1

BL-Analogic Bell 2

BL-Classic Tangerine

BL-Digital Bell 1

BL-Digital Bell 2

BL-Ensembells

BL-Fantasy D

BL-Fragile

BL-Generic

BL-Hi Bells

BL-Morph Wheel

BL-Moving Cycle

BL-OSC Bells

BL-So Pure

BL-Trendy Bell

Brass:

BR-BasiBrass

BR-Digital Horns

BR-Funky Simple

BR-Slow Analog

BR-Trumpets Rising

Bass:

BS-Daft Step

BS-Gimrillex

BS-Hendrix Wheel

BS-Meet the Lion

BS-New Age Layer

BS-Origantal

BS-Play One Note

BS-Repeat On Wheel

BS-Sub Grain

BS-Wheel Xperiment

BS-X Drone

BS-Xtravangaza Dubstep

Chord:

CH-8bit Stew Fly

CH-Bento Box

CH-Digital World

CH-Imaginaire

CH-Little Monster

CH-Saw Siscion

CH-Step and Wheel

CH-Very Wheel

CH-Wave Blader

CH-Wheelvolution

FX:

FX-Jarre Tribute

FX-Mayhem of B

FX-Zomb Bombs

Keyboard:

KB-Analog Clav

KB-Bell Keys

KB-CougOrgan

KB-Dynogital

KB-FargiGsa

KB-Majestic Organ

KB-Mini Wave Keys

KB-Sati Mood

KB-Synth Piano

KB-Synth Road

KB-X Soft Keys

Lead:

LD-Basic One

LD-Dream Poly Solo

LD-Guitar Air HO

LD-Harmolead

LD-Large Margin

LD-Moscito Bass Lead

LD-New Age Polysolo

LD-Scie Musicale

LD-Screamy Police

LD-Seventh Dimension

LD-Slow Solo

LD-Space Pan Flute

LD-Ultra Wet

LD-Very Short One

Pad:

PD-Bi Polaroid

PD-Dark Machine

PD-Geologic

PD-Harmo Pad

PD-Joy Wedding

PD-Mandela Spirit

PD-Mix Solage

PD-Multi Color

PD-No Doubt

PD-Play Long

PD-Port Arp Mentos

PD-Sweep FInal

PD-Teddys Glide

PD-Trance Wheel Me

PD-Trouble Double

PD-Ultra Dark

Polysynth:

PL-Agressive

PL-Creative Stab

PL-Morphession

PL-Pizica Early

PL-Poly Game

PL-Softy Plucky

PL-That Typical

PL-Xtreme Dorrs

Presets
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  MIDI Learn

Most UVI Workstation parameters can be automated via. a convenient 

MIDI Learn. MIDI Learn allows you to bind a physical MIDI controller 

to specific parameters within UVI Workstation.

  Any FX tab parameter, Macro Knob or Slider in UVI 

instruments can use the MIDI Learn feature

  The MIDI controller type and the MIDI Channel assignment will 

be saved with the multi or with your song in the host sequencer 

  Automation is assigned per-part

To use MIDI Learn:

1. Right-click the parameter in UVI Workstation 

that you want to automate

2. After the MIDI Learn dialog appears, Trigger the 

desired MIDI input controller (knob, fader etc.)

To remove a MIDI controller assignment: 

Right-click the desired parameter and press “Delete”

  Arpeggiator

UVI Workstation comes equipped with a robust arpeggiator.To insert 

an arpeggiator in a part, you need to display the Single view in the 

UVI Workstation, then click on the note icon. The arpeggiator can 

be employed as a pattern gate, arpeggiator, or even an advanced 

rhythmic processor for your live MIDI performance or sequenced MIDI 

tracks. Arpeggiators can be inserted in an unlimited number of parts.

  Preset Stacking

Thanks to the simplicity of the UVI Workstation you can stack as 

many preset as you want by simply assign multiple part on the same 

MIDI channel.

  Scroll Wheel

All knobs can be adjusted with the scroll wheel on your mouse. 

When you double-click on any knob or slider, you can manually enter 

or type in the desired value.

  Split, Velocity & Key Switch

The Keyswitch settings allow you to load multiple presets into two 

or more parts and dynamically play and mute them from your MIDI 

controller using key switching, note range, velocity range or any 

combination of the three parameters. This powerful feature gives you 

a great deal of real-time control.

  Unlimited FX

UVI Workstation offers a wide variety of FX, or effect 

processors, to cover all your audio processing needs. The FX 

implementation is robust and includes the ability to insert 

unlimited FX slots in several stages of the signal flow.

  Click the “FX” tab to open the FX page on the Single view 

  In Multi view the FX section is always displayed

UVI Workstation: Tips + Tricks
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